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CHAPTER 1  
Introduction 

MyoMED™ is a customizable state-of-the-art laboratory station for conducting studies on 
muscle contractility in vitro. The system consists of either four or eight myographs. Each 
myograph contains a high-resolution force transducer; a high-quality Radnoti™ water-
jacketed tissue bath, and an optional electrode assembly for tissue stimulation. The 
optional stimulator units are individually isolated to allow independent control of 
stimulation parameters in each myograph. 

MyoMED software displays the force recording for each myograph in chart recorder 
fashion. Modifiable stimulator parameters include pulse rate, pulse width, pulse 
amplitude, stimulus duration, pulse polarity (+, -, or AC), and stimulus repeat. These 
controls are all easily modified from the main data acquisition window.  

Computer Requirements 

• 3.0GHz Processor  
• 512MB RAM  
• Windows 2000 SP4 or XP  
• Two available PCI slots 

Catamount R&D Hardware Guide 

 

Figure 1-1 - Computer with DIG-729PCI Card and DIG-744 Card 
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Figure 1-2 – Force Transducer Interface Cabinet (with IO-200-4 and IO-115 Cards) 

 

 

Optional Stimulus Hardware Guide 

 

Figure 1-3 - Stimulus Interface Cabinet (with SG-510, PHM-152I and PHM-152COM Cards) 

 
 

Figure 1-4 - PHY-153 Stimulus Junction Box 

 

 



CATAMOUNT R&D, INC.  MYOMED 

- 3 - 

Radnoti Hardware Guide 

Refer to the Radnoti Manual for quantities and part numbers for all of the hardware 
shown below. 

 

Figure 1-5 - Radnoti Hardware Diagram 
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Figure 1-6 – Radnoti Force Transducer Front Panel 

 

 

 

Cable Guide 

 

Figure 1-7 – PHM-155E BNC Cable 

 

 

Figure 1-8 - SG-244 Cable 

 

Figure 1-9 – SG-219G DB-9 Cable (Only with Optional Stimulators) 
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CHAPTER 2  
Hardware Installation 

Some general considerations should be made prior to selecting a location for the 
completed MyoMED Myograph system.  The location should have both easy access to a 
vacuum line or pump to connect to the drain system of the Myograph and also have 
access to gas cylinders containing the gas mixture that will be used to aerate the tissue 
baths. 

Unpack all of the Myograph hardware and verify that all of the necessary hardware has 
been included.  Set up the computer and peripherals, referring to the instructions 
included with the computer. 

Radnoti Equipment Assembly 

Refer to the Radnoti Tissue Organ Bath System manual (included with the order) for 
detailed instructions regarding the assembly of the Radnoti hardware and plumbing, 
shown in Figure 1-5. 
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Connecting Force Transducers 

This section describes the connections required for the force transducers.   

NOTE:  Be sure that all hardware is disconnected from power prior to completing this 
section. 

 

Quick Reference 
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Step-by-Step Instructions 

1. Using the SG-244 cable connect the IO-115 Interface Card to the NI-DAQ DIG-744 
card as shown in Figure 2-1. 

 

Figure 2-1 – Connect IO-115 Card to DIG-744 Card Using the SG-244 Cable 

 

2. Using a PHM-255E BNC cable, connect the BNC Connector on the back of each 
Radnoti Force Transducer to corresponding INPUT connector on the IO-200-4 card, 
as shown in Figure 2-2. 

 

Figure 2-2 – Connect Radnoti Transducers to IO-200-4 Using BNC Cables 

 

3. Connect each Radnoti Force Transducer to a standard wall outlet. 

4. Apply power to the computer and the Force Transducer Interface Cabinet. 



CATAMOUNT R&D, INC.  MYOMED 

- 8 - 

Connecting Optional Stimulators 

If the myograph system was not purchased with the optional stimulator units, disregard 
this section. 

NOTE:  Be sure that all hardware is disconnected from power prior to completing this 
section. 

 

Quick Reference 
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Step-by-Step Instructions 

1. Mount the PHY-153 (shown in Figure 1-4) to the Support Rod (shown in Figure 1-5). 

2. Using the 10-foot long SG-219G cable, connect the PHM-152 COM Control Network 
Card to the DIG-729PCI Card, as shown in Figure 2-3. 

 

Figure 2-3 – Connect the PHM152 COM Card to the DIG-729PCI Card 

 

 

3. Using the 2-foot long SG-219G cable, connect the PHM-152 COM Control Network 
Cards as shown in Figure 2-4. 

 

Figure 2-4 – Connect the PHM-152 COM Cards 
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4. Using PHM-155E BNC cables, connect the STIM OUT connectors on each of the PHM-
152I Current Stimulator Cards to the corresponding STIM port on the PHY-153, as 
shown in Figure 2-5. 

 

Figure 2-5 – Connect PHM-152I Cards to PHY-153 Using BNC Cables 

 
 

5. Connect the electrode cables to the corresponding Electrode connectors on the PHY-
153, as shown in Figure 2-6. 

 

Figure 2-6 - Connect Electrode Cables to PHY-153 

 
 

6. Apply power to the computer and the Stimulus Interface Cabinet. 
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CHAPTER 3  
MyoMED Software 

MyoMED software is a customized data acquisition program designed specifically for 
performing contractility measurements in isolated tissues.  It is extremely powerful and 
easy to use. 

The MyoMED program acquires data from force transducers for each organ bath in the 
myograph system.  It provides a display of data during an experiment in chart recorder 
format.  The software allows the user to keep track of the timing of an experiment and to 
enter comments or event marks indicating when drugs are applied, for example.  For 
users who are performing electric field stimulation using our PHM-152 stimulator units, 
the stimulators can be controlled right from the MyoMED window.  Each organ bath 
receives input from an individually isolated stimulator so that users can study distinct 
stimulus protocols simultaneously.  Data files generated in MyoMED software can be 
viewed and analyzed using MyoViewer software (Chapter 4). 

MyoMED File Format Conventions 

MyoMED generates two types of files during data acquisition (Appendix C).  Scaled force 
data from each force transducer are saved in a binary format file with a .RAW extension.  
All event marks and text associated with an experiment are saved in an ASCII format text 
file with a .TXT extension.  Every experiment performed with MyoMED will consist of a 
RAW file and a TXT file.  When a file name is defined for an experiment, MyoMED will use 
that file name for the RAW and the TXT files.  The RAW and TXT files associated with a 
given experiment must have the same name.  For example, if an experiment is named 
“force”, the RAW file will be “force.raw” and the TXT file will be “force.txt.”  The names 
of these files should not be changed after they have been saved, unless both the RAW 
file and the TXT file are changed to have the same name.  MyoViewer data viewing 
software requires both the RAW and TXT files for a given experiment to have the same 
name (Chapter 4). 
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MyoMED Main Window Layout 

Figure 3-1 shows the MyoMED main window and its key features.  The functional parts of 
the MyoMED main window will be described in detail in later sections.  This section gives 
an overview of the items highlighted in Figure 3-1. 

 

Figure 3-1 - MyoMED Main Window 

 
 

There are four Data Display Windows, one for each myograph in a four-unit system 
(Figure 3-1).  If an eight-unit myograph system is being used, a second monitor displays 
a window that contains signals and controls related to organ baths 5 through 8.  Data 
Display Windows show tracings of the signals from the force transducers connected to 
their corresponding channels.  The current value from a force transducer can be read 
from the Current Data Point Indicator located to the left of and towards the bottom 
of each Data Display Window.  The Current Data Point Indicator is a digital meter that is 
labeled “Grams net.” 

There is an Event Mark Display Window located below each Data Display Window.  
This window is narrow and contains a blue line.  When an event occurs, a tick mark 
shows up in the blue line to indicate the event. 

The Channel Name corresponding to each of the data display and event mark windows 
is displayed in the center below each Event Mark Display Window. 

The space below the Data Display Window for Channel 1 has a Session Time Indicator 
and Display Grid Controls.  The Session Time Indicator is a timer that starts counting 
when starting to recording experimental data (Chapter 4).  It can be used to keep track 
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of the relative time during an experiment.  The Display Grid Controls allow the user to 
enable and disable grid marks in the Data Display Windows and to change their color.   

Settings for controlling the X-axis (time axis) are found below the Data Display Window 
for Channel 4.  Changing the X-axis settings affects the time scale for all channels 
simultaneously.  The X-axis Range Slider specifies the length of time (up to 30 
minutes) that is displayed in the Data Display Windows.  The maximum and minimum 
values for the X (Time)-Axis are also indicated.  Again, the values for the X (Time)-axis 
pertain to all channels.  The File Name Window below Channel 4 indicates the full path 
for the data file that is currently being recorded. 

The Channel Selector and TARE Button located in the bottom left corner of the 
MyoMED main window are the controls used for adjusting the offset for each channel. 

Users who have the optional PHM-152I stimulator units can control the stimulators 
directly from MyoMED.  The Stimulator Settings for each channel are displayed to the 
left of each Data Display Window.  To modify the stimulator settings, click the Edit 
Stimulator Button.  The stimulator is turned on and off by clicking the Stimulator ON/OFF 
Button.   

Clicking on the Event Mark Button, located to the right of each Edit Stimulator Button, 
brings up an event mark dialog box and places an event mark in the file. 

The Menu Bar at the top of the MyoMED window contains the File and Edit Menus. 
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MyoMED Menu Structure 

There are two main menus in the Menu Bar of the MyoMED window (Figure 3-1): File 
menu (Figure 3-2) and Edit menu (Figure 3-3). 

File Menu 

 

Figure 3-2 - File Menu 

 
 

Figure 3-2 shows the File menu as it would appear after an experiment has been started.  
The appearance of the commands in the File menu will change depending on whether or 
not an experiment is in progress.  Commands that are unavailable, or inactive, will 
appear grayed out, while commands that are active will appear solid. 

 

• Choose Start Session to begin recording data.  Start Session is only active 
before an experiment is started.  While data logging is in progress, the Start 
Session command will be grayed out (inactive). 

• Review is used during an experiment to inspect the contents of the data file.  
Review is only active during an experiment.  Before an experiment is started, 
Review is grayed out.   

• Choose Stop Session to stop recording data when an experiment is finished.  
Stop Session is only available while an experiment is in progress, and choosing 
Stop Session will not exit the MyoMED program. 

• Choose Quit to exit the MyoMED program. 

• Choose About to open the About dialog box, which contains copyright 
information and the current software version. 
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Edit Menu 

 Figure 3-3 - Edit Menu 

 
 

• Use Y-Scales to modify the range of the Y-axis (force) for each data display window.   

• The Edit menu also has standard Windows clipboard edit commands: Cut, Copy, 
Paste, and Clear.  These commands are only active when the cursor is in a text box. 

Controlling Programmable Stimulators (PHM-152) From MyoMED 

MyoMED data acquisition software provides an intuitive interface from which to control 
the PHM-152I series stimulators for performing experiments where electric field 
stimulation is desired.  All stimulator settings and adjustments can be controlled right 
from the software.  No hardware adjustments are needed.  The MyoMED main window 
contains a display of the stimulator settings for each channel in the myograph system 
(Figure 3-1).  If the myograph system was purchased without the PHM-152 stimulator 
units, the stimulator control functions within MyoMED software will be non-functional.  If 
your system does not have the PHM-152 stimulators and you would like to upgrade, it is 
a simple matter of purchasing the stimulator units and the computer interface card.  No 
changes to the MyoMED software are necessary.   

Stimulator Settings Display 

The Stimulator Settings display is located to the left of each channel in the MyoMED main 
window (Figure 3-1).  Each channel has a corresponding Stimulator Settings display.  The 
Stimulator Settings display indicates the current stimulator settings.  Figure 3-4 shows an 
expanded view a single Stimulator Settings display. 

 

Figure 3-4 - Stimulator Settings Indicator 

 

Stimulator settings can be changed at any time simply by clicking the EDIT button.  Each 
channel has its own EDIT stimulator button. 
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Stimulus Parameters Defined 

Individual Pulse Parameters 

• The Pulse Width defines the duration of a single stimulus pulse.  Units for the 
pulse width are milliseconds, and typical values are in tenths of a millisecond 
range.  The range of the pulse width is 0.1 to 32 ms, depending on the 
frequency. 

• The Pulse Intensity defines the amplitude of a single stimulus pulse.  For the 
PHM-152V constant voltage stimulators, pulse amplitudes are given in volts.  
For PHM-152I constant current stimulators, pulse amplitudes are given in 
milliamps.  The range of the pulse intensity is 0 to 40 Volts (0 to 400 
milliamps).  

• Pulse Polarity defines the polarity of an individual stimulus pulse.  As shown 
in Figure 3-5, pulses can be positive, negative, or alternating polarity, referred 
to as DC+, DC-, or AC (+/-) for convenience.  When trains of pulses are to be 
used, setting the pulse polarity to alternate (AC+/-) minimizes electrode 
polarization.  This helps avoid stimulus artifacts due to electrode polarization. 

 

Figure 3-5 - Individual Pulse Parameters 
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Pulse Train Parameters 

• Pulse Frequency is the number of stimulus pulses per second.  The range of 
the pulse frequency is 1 to 2000 pulses per second, depending on the pulse 
width. 

• The Stimulus Duration is the length of time, in seconds that a train of pulses 
is applied.  The minimum stimulus duration is 0.01 seconds and the maximum is 
the time it takes to generate 65,500 pulses. 

• The Repeat Mode determines whether or not a stimulus train will be repeated.  
The options are ON, OFF and File.  Refer to the Repeat Mode section of this 
manual (below) for more detailed information. 

• If it is desired to have a pulse train repeated at set intervals, the Repeat Time 
defines the amount of time (in mm:ss) from the start of one pulse train to the 
start of the next pulse train. 

 

Figure 3-6 - Pulse Train Parameters 
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Making Changes to the Stimulator Settings 

To make changes to stimulator settings, click on the Edit stimulator button 
corresponding to the stimulator for the channel to change (Figure 3-1 and Figure 3-4).  
The Edit Stimulator window will appear (Figure 3-7). 

 

Figure 3-7 - Edit Stimulator Window 

 
 

The Channel Indicator shows which stimulator is currently being edited.  Pulse Polarity is 
chosen from a drop down selector containing the available choices: DC+, DC-, AC+/-.  
Pulse Frequency, Pulse Width, Pulse Intensity, Stimulus Duration, and Repeat Rate are all 
set by either manually typing in the desired setting in the corresponding selector box or 
using the up/down arrows to the left of each box.  The Repeat Mode is chosen from a 
drop down selector containing the available choices: ON, OFF, or File.  Settings for 
Repeat Rate are only active if the Repeat Mode is set to ON. 

When the changes to the stimulator settings are complete, click the OK button.  Exit the 
Edit Stimulator window without making any changes by clicking the Cancel button. 

When the stimulator is set to manual mode, i.e. Repeat Mode is set to OFF, or when 
Repeat Mode is turned ON, stimulator settings can be edited at any point during data 
acquisition.  Set the Repeat Mode to File if using pre-programmed protocol files 
(Chapter 5). 

To review, when it is desired to change stimulator settings, click on the Edit stimulator 
button to open the Edit Stimulator window.  Make the desired changes to the stimulator 
parameters and click OK to exit.  Once back to the MyoMED main window, the settings 
that were just made should be displayed in the Stimulator Settings Indicator for the 
corresponding channel.  If operating the stimulator in manual mode (i.e. Repeat is set to 
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OFF), the Stimulator ON/OFF button will have a bright red color (Table 3-1).  To activate 
the stimulator, click the Stimulator ON/OFF button.  The Stimulator ON/OFF button will 
flash bright green while the stimulus is being delivered.  As soon as the stimulus is 
completed, the Stimulator ON/OFF button will return to a bright red color, indicating the 
stimulator is OFF.  The color of the Stimulator ON/OFF button indicates important 
information about the status of the stimulator.  Table 3-1 shows the various Stimulator 
ON/OFF button colors and defines their meanings. 

 

Table 3-1 - Stimulator Light Indicators and their Meanings 

 

Using the Repeat Mode 

If it is desired to stimulate the preparation using the same parameters at set intervals, 
set the Repeat Mode to ON.  Enter the desired Repeat Rate in the Edit Stimulator 
window.  The Repeat Rate is the amount of time from the start of one stimulus to the 
start of the subsequent stimulus, refer to Figure 3-6.  For example, if the Repeat Mode 
is ON and the Repeat Rate is set to 1:30 (1 minute 30 seconds), the selected stimulus 
parameters will be repeated every minute and a half.  Click on the Stimulator ON/OFF 
button to deliver the first stimulus, the button will flash bright green (Table 3-1).  When 
the stimulus is finished, the button will stay bright green, indicating that the stimulator is 
in standby waiting for the time between repeats to elapse.  When the time set as the 
Repeat Rate has elapsed, the stimulator will automatically deliver the stimulus using the 
same settings.  The repeating will continue until the Stimulator ON/OFF button is 
clicked again.  The button will change to bright red indicating that the stimulator is OFF.  
If the stimulator is in Repeat Mode, Edit can be clicked to change certain settings 
between successive repeats.  This is useful if it is desired to increase or decrease certain 
parameters from stimulus to stimulus. 
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Using Repeat Mode with Protocol Files 

A more advanced and powerful way to change stimulus settings between successive 
stimulations is to use the “File” feature of Repeat Mode.  Setting Repeat Mode to File 
will load a pre-programmed stimulus protocol into memory and execute stimulations 
based on parameters set in the file.  To use a pre-programmed protocol, click the Edit 
button for the desired stimulator(s).  From the Repeat Mode selector, choose File.  This 
will open a window titled “Select Control File” (Figure 3-8).  Browse to the directory 
where the protocol file was stored.  It should have a “txt” extension.  There is a sample 
protocol file called Sample.txt that is installed in the …\MyoMED\Tables directory.  
Highlight the protocol file and click OK.  Click OK once again from the Edit Stimulator 
window to return to the main MyoMED window.  The Stimulator Settings Indicator (Figure 
3-1 and Figure 3-4) should show File listed for the Repeat Mode along with the first set 
of stimulus parameters.  The Stimulator ON/OFF button should be bright red, 
indicating the stimulator is OFF.  During an experiment, when the Stimulator ON/OFF 
button is clicked for a stimulator that has a protocol file loaded, the stimulator will 
deliver the first stimulus and then go into standby while waiting for the Repeat Time to 
elapse before delivering the next stimulus.  After a stimulus is delivered, the Stimulator 
Settings Indicator will be updated automatically to reflect the settings that will be used 
in the next stimulus.  As soon as all the stimulations coded for in the protocol file have 
been delivered, the stimulator will automatically turn OFF, the Stimulator ON/OFF 
button will change to bright red to indicate the stimulator is OFF, and the Stimulator 
Settings Indicator will be updated with the parameters for the first stimulation coded 
for by the file.  If the Stimulator ON/OFF button is clicked again, the stimulator will 
execute the stimulations in the protocol file once again. 

 

Figure 3-8 - Loading a Stimulus Protocol File 
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Using Event Marks 

Each channel has a corresponding Event button located to the left of the Data Display 
Window (Figure 3-1).  Pushing the Event button places a tick mark on the blue trace 
located in the Event Mark Display Window (Figure 3-9) and opens the Enter Event 
window (Figure 3-10). 

 

Figure 3-9 - Event Marks 

 
 

The Enter Event window (Figure 3-10) allows the user to type in a text comment that 
will appear in the recorded data file at the time of the experiment when the Event 
button is pressed.  Enter the comment in the EVENT Text box. 

 

Figure 3-10 - Enter Event Window 

 
 

Setting Up Event Lists in Windows Notepad 

It may be found that there will be several events that are identical from experiment to 
experiment, such as doses of drugs that will be added in a cumulative manner.  Rather 
than entering in the same event over and over, it may be easier to create a text file in 
Windows Notepad that contains a list of some frequently used events (Figure 3-11).   

To construct such an event list, open Windows Notepad, which is located in the 
Accessories folder of the Windows Start Menu.  Type each individual event on a 
separate line of the Notepad file (Figure 3-11).  When all of the events are listed in 
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Notepad, save the file with a name such as “EventMarks.txt” that will allow it to be 
located easily at a later date.  Each time that MyoMED is run, have the Notepad file 
loaded in the background.  Entering events in MyoMED is then a simple matter of clicking 
the Event button, copying an event text from the Notepad file, and pasting it into the 
Enter Event window.  The Enter Event window does have an Edit menu with the 
Windows clipboard edit commands.  Shortcut keys (Control+C = Copy, Control+V = 
Paste) may also be used.  Another great solution is to use a mouse that has 
programmable buttons.  Program the buttons for the Windows Copy and Paste commands 
and use these shortcut buttons to copy and paste events from Notepad to MyoMED. 

 

Figure 3-11 - Event Mark File in Notepad 

 

Changing the Offset 

The offset for each channel is controlled using the TARE button located in the bottom 
left corner of the MyoMED window (Figure 3-1, Figure 3-12).  Use the offset control at 
the beginning of an experiment when hanging the preparation from the force transducer.  
The TARE button zeros the signal from the force transducer that is currently selected in 
the Channel selector (Figure 3-12).  When hanging the tissue hook from the force 
transducer, pressing the TARE button will negate the weight of the hook.  TARE each 
force transducer just prior to applying any load to the preparation. 

 

Figure 3-12 – Channel Selector and TARE Button 
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Changing the Appearance of Data Display Windows 

Setting the X-Axis and Y-Axis Scales 

To change the scale for the Y-axes, select Y-Scales from the Edit menu (Figure 3-3).  
This opens the Edit Y-Scale Values window (Figure 3-13). The MAX and MIN values 
for any of the channels in the myograph system can be changed.  When the desired 
changes have been made, click OK.  Clicking on Cancel will keep the Y-axes the same as 
they were before opening the Edit Y-Scale Values window. 

 

Figure 3-13 - Changing the Y-Axes Scales 

 
 

The X-axes (Time) can be set to show from 1 to 30 minutes of data during data 
acquisition.  Change the X-axis range by using the X-axis Range Slider located below 
the Data Display Window for Channel 4 (Figure 3-1, Figure 3-14). 

 

Figure 3-14 - X-Axis Range Slider 

 
 

Enabling Grid Lines 

The grid lines in the Data Display Windows can be enabled/disabled.  To enable grid 
lines, click the Grid button located below the Data Display Window for Channel 1 
(Figure 3-1).  To change the grid line color, click the Color button (next to the Grid 
button) and select the desired color.  To turn grid lines off, click on the Grid button 
again. 
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Reviewing an Experiment During Data Acquisition 

When in the middle of an experiment and recording data, the entire contents of the 
experiment can be examined up to the present point in time by selecting Review from 
the File menu.  This opens a separate window running MyoViewer software.  Refer to 
Chapter 4 for operation of MyoViewer software.  Keep in mind that reviewing an 
experiment in progress can be very slow, depending on how large the data file is at that 
point.   
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CHAPTER 4  
MyoViewer Software 

MyoViewer software is a user-friendly program for off-line inspection of RAW files 
recorded in MyoMED data acquisition software.  Basic data analysis routines, such as 
measuring the average contraction force during a given treatment, can be performed in 
MyoViewer.  For more demanding analysis techniques, the user can export selected 
regions of data as ASCII text files for importing into a spreadsheet or other analysis 
program.  The export feature of MyoViewer is also very helpful for constructing 
publication-quality illustrations of the raw data.  Please feel free to contact the staff at 
Catamount Research and Development, Inc. for assistance. 

MyoViewer Layout 

MyoViewer Main Window 

This section provides an overview of the MyoViewer main window (Figure 4-1).  All of the 
functions are discussed in more detail in subsequent sections. 

 

Figure 4-1 - MyoViewer Main Window 
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The MyoViewer Window is made up of six distinct sections (Refer to Figure 4-2):   

• Section 1 is the most important section of the MyoViewer Window, the Data Display 
Window.  This display shows a trace corresponding to the force signal recorded 
during an experiment.   

• Section 2 contains information about the current file, including the file path, channel 
displayed, and total experiment time.   

• Section 3 lists all of the event marks that were entered during an experiment in a 
spreadsheet format.  For each event, the event mark section contains the time of the 
event, the parameters of the electric field stimulator (if used), the amplifier gain at 
that point of the experiment, and any comments entered as text into the Event Mark 
box.   

• Section 4 is the Graph Control Section.  This section contains all controls for changing 
the properties of the data display window.  This includes adjusting the X- and Y-axes, 
changing the color of the data trace line, and enabling/disabling grid mark display.   

• Section 5 is the Cursor Control section, which contains settings for the navigation 
cursors.  There are three cursors used to navigate a file: Cursor A, Cursor B, and 
Event Cursor.  Cursor colors can be modified in the Cursor Control section.   

• Section 6 is the Data Analysis Section.  This section contains basic statistics for the 
data between cursors A and B.  These include average force between the cursors, 
maximum and minimum values between cursors, difference in force between cursors 
A and B, etc. 

 

Figure 4-2 - Six Sections of the MyoViewer Window 
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MyoViewer Menu Structure 

In addition to the major sections of the MyoViewer main window, there are three menus 
that contain additional settings/functions.  The three menus are the File menu (Figure 
4-3), Edit menu (Figure 4-4), and Export menu (Figure 4-5). 

File Menu 

Figure 4-3 - File Menu 

 

 

The File menu  (Figure 4-3) is divided into 4 sections.  The first section contains the 
Open and Save options. 

• Use the Open command to open either a New File or a new Channel in the 
currently loaded file. 

• Use the Save command to save any changes made to the event mark comments.  
Save does not alter raw data or information in the original event mark file.  A 
new file is created with the modified event comments. 

The next section contains options for printing hard copies of the data displayed in the 
MyoViewer data display window.  MyoViewer will print only to the default Windows 
printer.  If it is desired to print to a printer other than the default Windows printer, the 
default Windows printer must be changed prior to starting MyoViewer software. 

• The Save Plot As option is used to save the printout to disk.  This command 
generates three files, two of which have the *.png extension, and a third file with 
an .htm extension.  The HTML (.htm) file is the actual file that contains the 
desired printout.  This file uses the png files to construct the images it contains.  
If the png files are deleted or moved, the HTML file will not work properly. 

• The Print option sends a printout of the data currently displayed in the data 
display window, along with event mark information associated with the data, to 
the default Windows printer. 

• The Page Orientation option allows the user to print in either Portrait or 
Landscape orientation. 
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The next section of the File menu has the Quit command. 

• Select Quit from the File menu to exit the MyoViewer program. 

The last section of the File menu has the About command. 

• Use About to view information regarding the version of MyoViewer being run. 

Edit Menu 

Figure 4-4 - Edit Menu 

 
 

The Edit menu (Figure 4-4) contains basic Windows edit tools: Cut, Copy, and Paste.  
These functions are used only when making changes to the event mark comments.  Refer 
to section 3 of Figure 4-2. 

Export Menu 

Figure 4-5 - Export Menu 

 
 

The Export menu (Figure 4-5) has options for exporting selected regions of data from 
the data display window.  The exported file can then be imported into a graphing or 
spreadsheet program for further analysis or construction of figures. 

• Use the Compression setting to determine the compression of the data file.  
None will export all data points within the range specified.  Selecting 2X, 5X, or 
10X will compress the file by saving every other data point, every fifth data 
point, or every tenth data point, respectively. 

• Select ABF to export the data into an axon binary file (*.ABF).  The ABF submenu 
allows the user to select the range of data to be exported. Selecting Channel 
(All) will export data from the entire channel that is currently loaded, A-B 
Cursors will export only the data between cursors A and B and Display will 
export the data that is currently displayed in the data display window. 

• Select TXT to export the data into a text file (*.TXT).  The TXT submenu allows 
the user to select the range of data to be exported.  Selecting Channel (All) will 
export data from the entire channel that is currently loaded, A-B Cursors will 
export only the data between cursors A and B and Display will export the data 
that is currently displayed in the data display window. 
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Opening a File 

When MyoViewer is first started, the Open file dialog box is displayed (Figure 4-6A).  
Select the RAW file to load.  After selecting the RAW file, the Import Channel dialog 
box appears (Figure 4-6B).  Select the desired channel to load.  The number of channels 
listed will depend on the version of MyoMED being used.  Loading a file can take several 
minutes, depending on the size of the file and the speed of the computer.  While the file 
is loading, the progress indicator will change from red to green.  If a file is currently 
open and an additional file needs to be opened, go to the File menu and choose 
Open New File (Figure 4-3). 

 

Figure 4-6 - Opening a File in MyoViewer 

 

 

Once a file is loaded, the MyoViewer window will look similar to Figure 4-1.  The path of 
the currently loaded file is displayed in the File information section (part 2 on Figure 
4-2).  The channel number that is currently loaded is displayed next to the file path.  The 
Session Duration is displayed on the left side of the screen, above the data display 
window.  This information indicates the total time (hours:minutes:seconds) of the 
experiment that is currently loaded. 

Selecting a Different Channel 

If it is desired to change to a different channel in the currently loaded file, simply press 
the New Channel button next to the file path above the data display window, or choose 
File Open New Channel.  In either case, the Import Channel dialog box will be 
displayed (Figure 4-6B). 
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Event Marks Associated With a RAW Data File 

When experimental data is acquired using MyoMED, two files are saved: a RAW file that 
contains the force transducer signals in binary format, and a TXT file that contains 
information and comments about events that occurred during the experiment (Appendix 
C).  When a file is loaded into MyoViewer, the event marks are displayed as a 
spreadsheet in the Event Mark section of the MyoViewer window (part 3 of Figure 4-2; 
Figure 4-7).   

 

Figure 4-7 - Event Mark Section in MyoViewer 

 
 

• The Time column shows the time in the experiment that the event occurred.   

• The Rate, Pol, Width, Dur, Volts, and Rep columns all contain information about 
the stimulator settings.   

• The Gain column indicates the amplifier gain setting at the point in the experiment 
that a given event occurred.     

• The Comments column lists any text entered into the Event dialog box during an 
experiment.  The first row of the event mark section shows the absolute time the 
experiment was started (determined by the clock setting on the computer).  The 
comments section of the first row indicates the date the file was created, the path of 
the file name, and the data sample rate in seconds per sample.  All subsequent rows 
list the events that occurred during an experiment.  The time information for 
experiment events is the relative time, with time zero being the beginning of an 
experiment. 

Jumping to a Specific Event in an Experiment 

Use the scroll bar on the right side of the event mark spreadsheet to scroll up and down 
through the list of events.  Jump to a specific event in an experiment by clicking the 
mouse pointer on any of the columns, other than the comments column, for the desired 
event in the event mark spreadsheet.  By default, the event jumped to will be at the left-
most edge of the data display window.  If it is desired to have a segment of data 
displayed before (to the left of) the event of interest, change the Preview setting, 
located next to the event mark spreadsheet.  The default value of 0 seconds results in 
the event of interest being placed on the left-most edge of the data display window.  If 1 
min of data should be displayed before the event of interest, enter 60 seconds into the 
Preview setting, and click on the event of interest in the event mark spreadsheet.  The 
event of interest will now be preceded by 60 seconds of data in the data display window.  
The Event cursor in the data display window indicates the event of interest that was 
selected by clicking in the event mark spreadsheet.  Each time a new event is clicked on, 
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the data display window will jump to that point of the experiment, and the Event mark 
cursor will indicate the selected event.   

Modifying Event Mark Comments 

While working with files in MyoViewer, it is possible to modify the comments for any 
event that occurred during an experiment.  This option is particularly useful if there is an 
error in the event comment or if it is desired to append information to an event, such as 
cursor data measurements.  Note that only the Comments section can be modified.  The 
other parameters of the events cannot be changed. 

To change the text in the Comments section of the event mark, simply place the cursor 
in the Comments section to be modified.  Text can be entered/manipulated in the 
Comments section just like any other Windows application.  Use the Edit menu (Figure 
4-4) to Cut, Copy, or Paste information in the Comments section. 

 

Figure 4-8 - Save Edits Controller 

 
 

Once the desired changes have been made, there are a number of ways to save the 
changes to disk.  To save the altered comments to the original TXT file that was created 
with the RAW file during data acquisition, use the Save Edits control located to the left 
of the event mark spreadsheet (Figure 4-7 and Figure 4-8).  By default, this control is set 
to Never, which means that any changes made to the comments will not alter the 
original TXT events file.  Changing this controller to Always will result in the comment 
changes being saved over the original TXT file comments automatically when quitting 
MyoViewer, loading another file, or loading a new channel.  Setting this controller to Ask 
Me will cause MyoViewer to prompt the user to select whether or not to save the 
changes to the original TXT file as soon as MyoViewer is quit, another file is loaded, or a 
new channel is loaded (Figure 4-9).  Choosing OK in response to the prompt will write 
the changes over the original TXT file.  Choosing Cancel will discard the changes. 

 

Figure 4-9 - Ask Me Save Edits Prompt 
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The other option for saving modified event comments is to use the Save command in the 
File menu (Figure 4-3).  Using File Save will open a Save As dialog box prompting the 
user to enter a file name (or use the default name provided) that has a CHx extension, 
where x is the channel number of the desired file.  Choosing this method will not affect 
the original TXT file containing event mark information saved during data acquisition.  
Unlike the original TXT event mark file, which contains events for all channels in the 
myograph system, the CHx file contains only the modified events for the channel it was 
created for.  For example, if viewing channel 3 of a data file, and errors are noticed in 
the event comments, the comments may be changed and File Save selected.  The 
resulting file would be in ASCII format, and would have “CH3” as its extension. 

Using the Data Display Window 

The data display window (Section 1 on Figure 4-2; Figure 4-10), in conjunction with its 
related sections, is where the bulk of the focus will be while using MyoViewer.   

 

Figure 4-10 - Data Display Window with Graph and Cursor Control Sections 

 
 

When a file is loaded into MyoViewer, the data recorded during an experiment will be 
displayed in the data display window, and will look similar to Figure 4-10.  The Y-axis 
range is –10 grams to +10 grams, and the X-axis range is 0 to 30 minutes by default.  
These ranges can be changed quite easily using the graph controls. 
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Changing the X-Axis and Y-Axis Settings 

 

Figure 4-11 - X-Axis Controls 

 
 

Changing the length of time displayed in the data display window is done using the X-
Range slider and scroll bar located in the bottom right corner of the screen (Figure 4-11).  
The length of time displayed in the data display window is indicated by the position of 
the red arrow on the X-range slider.  Figure 4-11 shows a setting of 30 minutes.  A value 
can be entered in the X-Range box.  Unlike MyoMED data acquisition software, which is 
limited to displaying 30 minutes in the display windows, MyoViewer can display any 
length of time greater than or equal to 1 minute.  To increase the maximum time 
displayed highlight the maximum value under the X-range slider, type in a new value, 
and press enter.  The X-range slider will be updated to reflect the change.  Move the red 
pointer to any position on the slider to set the amount of time displayed in the data 
display window.  To navigate through the file while maintaining the length of time 
displayed constant, move the scroll bar located above the X-range slider. 

 

Figure 4-12 - Y-Axis Controls 
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The Y-axis can be adjusted using the Y-Axis slider control located to the right of the data 
display window (Figure 4-12).  Moving the top green pointer changes the maximum force 
on the Y-axis.  Moving the lower blue pointer adjusts the minimum force displayed on the 
Y-axis.  These values may also be entered manually into the text boxes above and below 
the Y-axis slider.  Furthermore, if it is desirable to work within a more limited range of 
forces, the range of the Y-axis slider may be changed from the default of –10.0 grams to 
+10.0 grams to any range of interest.  To change the range on the Y-axis slider, 
highlight the maximum or minimum value, type in a new value, and press enter.  The 
slider will be updated to reflect the change.  For example, if the forces measured in a 
particular experiment range from 1 to 3 grams, the minimum value on the slider could be 
changed to 0.0 grams and the maximum value to 4.0 grams, and this would give more 
precise control over the Y-axis while using the pointers on the slider. 

Figure 4-13 shows an example where the X- and Y-axes have been adjusted to show the 
contents of an entire experiment.  Contrast the X- and Y-axis range sliders in Figure 4-10 
and Figure 4-13. 

 

Figure 4-13 - Adjusted X- and Y-Axes 
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Displaying Grid Marks and Modifying Line Colors 

The data display window can be configured to display grid marks for both the X- and Y-
axes.  To enable the X-axis grid marks, click on the X.XX button located below the data 
display window (Figure 4-14, green arrow).  Highlight Grid Color from the pop-up menu.  
Place the mouse pointer over the desired grid line color, and the grid lines will be 
displayed (Figure 4-14).  To enable the Y-axis grid marks, repeat this process after 
clicking the Y.YY button below the data display window. 

 

Figure 4-14 - Turning on Grid Marks 

 
 

To alter the line color of the force trace, click on the Line button (Figure 4-15, green 
arrow).  Select Color from the pop-up menu, and place the cursor over the desired line 
color.  The trace in the data display window will be updated accordingly. 

 

Figure 4-15 - Changing the Line Color 
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Cursor Properties 

There are three cursors in the data display window: Cursor A, Cursor B, and Event 
Cursor.  Cursors A and B are used to make measurements and define regions of data to 
export as ASCII files.  The Event Cursor indicates the position of the most-recently 
selected event from the Event Mark list.  Cursor properties can be changed in the Cursor 
Control section of MyoViewer (Section 5 on Figure 4-2; Figure 4-16).   

 

Figure 4-16 - Cursor Control Section 

 
 

The X and Y positions of each cursor are displayed next to the cursor names.  To change 
the cursor properties, click on the Cursor button corresponding to the cursor to be 
changed (Figure 4-16, red box).  This brings up the cursor properties menu.  Cursor 
color, style, and thickness can all be changed from this menu.  Another useful feature is 
the Bring to Center command.  Use this command to relocate a cursor to the center of 
the screen while navigating throughout a file. 

Making Measurements With the Cursors 

Cursors A and B can be positioned to make some basic measurements from data files, 
such as contraction amplitudes.  For example, to measure the peak of a contraction, 
place Cursor A at the baseline and Cursor B at the peak (Figure 4-17A).  The absolute X- 
and Y-positions for Cursors A and B can be seen in the Cursor Properties section.  The 
Cursor Data section to the left of the data display window shows the relative 
measurements between Cursor A and B.  Keep in mind that the relative data are taken as 
the Y-position of Cursor A subtracted from the Y-position of Cursor B (B-A).  When 
measuring contraction amplitudes, always place Cursor A at the desired baseline position 
and place Cursor B at the peak position.  The Force (g) summarized in the Cursor Data 
section in the example from Figure 4-17A shows a reading of 0.4566.  This value is the 
amplitude of the contraction. 
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Figure 4-17 - Using the Cursors to Make Basic Measurements 

 
 

Another way to use the cursors is to measure the average force between Cursor A and 
Cursor B (Figure 4-17B).  For example, to measure the steady-state force during a 
contraction, place Cursor A and Cursor B at the desired spacing.  In Figure 4-17B, 
Cursors A and B were placed at the steady state of a contraction.  The cursors were 
placed one minute apart.  The spacing between the cursors can be determined by 
observing the value in the Time hh:mm:ss window in the Cursor Data section.  In this 
example, the average (Mean) force during the one-minute interval between Cursors A 
and B is 0.5788 g.  The maximum (Max) force during that interval is 0.6001 g, and the 
minimum (Min) force is 0.5571 g. 

Exporting Data as an ASCII (*.txt) File 

For some purposes, more advanced analysis must be performed on the data, or a figure 
based on the raw data recordings in an experiment will be created for publication.  In 
these cases, it is desirable to export selected regions of data to be manipulated in 
another application, such as a spreadsheet or graphics program.  There are several 
options available for exporting data from MyoViewer.  The compression settings can be 
especially useful when exporting large sections of data, such as an entire channel, to use 
in constructing a representative figure.  For data analysis purposes, it is generally not 
advisable to use compression, as the resulting data could be affected. 

Event Mark Cursor 

The vertical position of the Event Cursor is especially important when it comes to printing 
a hardcopy of the data shown in the data display window. 

By default, Cursors A and B can be moved along a trace by using the mouse to drag 
them to desired locations.  In contrast, the Event Cursor can be freely moved anywhere 
in the data display window using the mouse to drag it around.  When the user clicks on 
an event of interest in the event mark list above the data display window, the data 
display window will jump to that location in the file, and the Event Cursor will indicate 
the position of the event.  Depending on the Y-axis scale settings, the Event Cursor may 
be in an undesirable location.  For example, the Event cursor may not show up at all, it 
may be located way at the bottom of the data display window, or it may be 
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superimposed on the data trace.  If the Event cursor doesn’t show up at all, recall it to 
the center of the data display window.  Once the Event cursor is visible, orient it in the 
desired vertical position.  The Y-axis scaling can be adjusted to eliminate extraneous 
space below the trace.  Once the desired vertical position of the Event Cursor is set, it 
will appear in this vertical position whenever subsequent events in the event mark list are 
clicked on. 

Printing a Hardcopy of Experimental Recordings 

It is often desirable to have a hardcopy of the experimental results available for archiving 
and quick inspection of the results.  A copy of the contents of the data display window 
can be printed using the Print command in the File Menu.  The File Menu section 
summarizes the options for printing from MyoViewer.  Appendix D shows a sample of the 
printout obtained from MyoViewer using the Print command.  Notice that the raw data 
recording appears at the top of the page, along with a summary of all the events below 
the trace.  There are numbered event marks that indicate the position of the events.  The 
event list below the trace is numbered to correspond to the event marks.  The position of 
the event marks (Y-axis position) in the printout will be defined by the Y-axis position of 
the Event Cursor in the data display window.  Before printing, be sure that the Event 
Cursor is in the desired vertical location, and that the X- and Y-axes are scaled in the 
desired manner. 
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CHAPTER 5  
Running an Experiment 

This chapter provides a brief overview of the basic process involved when performing 
experiments with MyoMED.  It is assumed that users have read through prior sections to 
understand the features of MyoMED software.  The information in this chapter serves as 
a quick reference highlighting important steps that are common to all experiments with 
MyoMED.  Individual users will develop their own systems depending upon the nature of 
the experiments they will be performing. 

To calibrate the force transducers, refer to Appendix A.  Catamount Research and 
Development, Inc. recommends calibrating force transducers during initial setup of the 
myograph system, and then periodically depending on how frequently the system is used.  
Once a month calibrations should be sufficient in most cases. 

Procedure Checklist 

1. Turn on the computer and all electronic devices and leave them on while preparing 
for an experiment (making solutions, dissecting, specimen preparation, etc).  This 
should be an adequate amount of time for the system to warm up, which will 
minimize force transducer drift during an experiment. 

2. Once the MyoMED software is loaded, set the stimulator settings (if used). 

3. Open the Windows Notepad file containing event mark text. 

4. Turn the heated water circulating pump(s) on to allow the water jacket to warm up to 
the appropriate temperature. 

5. Fill the water-jacketed saline reservoir with the saline solution to be used for 
experimentation.  Turn on the gas cylinder to equilibrate the saline with the 
appropriate gas mixture. 

6. If there is a vacuum pump connected to the tissue bath drain system, turn it on. 

7. Complete any dissections or manipulations that are necessary to prepare the muscle 
tissue specimen for study in the myograph. 

8. Fill the tissue baths with saline from the 2 L saline reservoir.  Adjust the flow of 
saline to each reservoir from the 2 L reservoir using the corresponding stopcock.  
Adjust the level of saline in each tissue bath by opening the stopcock connected to 
the vacuum system to remove excess saline.  Adjust the flow of gas into the tissue 
bath using the needle valve on the tissue bath oxygenator.   

9. To mount a tissue sample in a tissue bath, make sure that the tissue bath is lowered 
out of the way of the tissue support rod (Figure 5-1).  Begin by hanging a tissue 
attachment hook to the force transducer (see Figure 5-1).  Depending on the type of 
specimen, the tissue attachment hook may vary.  For example, the hook styles for 
vascular ring segments and smooth muscle strips are different.  Use the hook that is 
appropriate for the type of sample being used. 
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Figure 5-1 - Tissue Bath Position for Hanging Tissue Samples 

 

10. When the upper tissue hook is hanging from the force transducer, TARE the weight of 
the hook so that it does not add an offset to the force measurement.  (The use of a 
different upper tissue hook requires adjusting the load amplifier knob to “0” and 
running the full calibration procedure as outlined in Appendix A).  In the MyoMED 
window, choose the channel being used with the Channel Selector in the bottom left 
corner (see Figure 3-12).  Press the TARE button.  The “Grams net” (Figure 3-1) 
field of the Current Data Point Indicator for the selected channel should go to 
0.000 grams. 

11. Hang the tissue from the top hook first. 

12. Attach the tissue to the bottom hook.  Ensure that the specimen is slack while doing 
this.  Do not apply unnecessary stretch to the specimen, as it may damage the 
muscle.  If there are stimulating electrodes on the rigid tissue support rod, be sure 
that the specimen is situated between the two electrodes (Figure 5-1). 

13. When the tissue is connected to the upper and lower hooks, submerge the tissue 
support rod in the saline-filled tissue bath by raising the tissue bath.  Make sure the 
tissue is completely slack (no tension on the specimen).  Check this by moving the 
upper and lower tissue support hooks closer together by turning the micrometer 
head.  As the upper and lower hooks are moved closer, there should be no change in 
the force reading (as viewed in the Current Data Point Indicator, Figure 3-1).  
When it is certain that the specimen is slack, press TARE once again to cancel any 
offset that is present. 

14. Change the Channel Selector (Figure 3-12) to the next tissue bath and repeat the 
tissue attachment procedure. 

15. When all of the samples are mounted in tissue baths, the system is ready to begin 
recording data. 

16. To begin recording data, Choose Start Session from the File menu.  This opens the 
File Name window (Figure 5-2).  Type in a file name for the experiment.  The name 
that is chosen will be used for both the TXT file containing event comments and the 
RAW file containing raw data.  Click OK. 
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Figure 5-2 - Starting an Experiment in MyoMED 

 
 

17. At this point, data is being recorded from each channel.  Traces will appear in the 
Data Display Windows that correspond to the force measured by each force 
transducer. 

18. The user may now apply stretch to the samples by turning the micrometer heads.  
Estimate the amount of stretch by looking at the Current Data Point Indicator 
while the tissue is being stretched. 

19. Conduct the experiment.   

20. When the experiment is completed, stop recording data by selecting Stop Session 
from the File menu (Figure 5-3).  Quit MyoMED by choosing Quit from the File menu. 

 

Figure 5-3 - Stopping an Experiment 

 
 

21. If another experiment will be completed, it is a good idea to exit MyoMED software 
and reload MyoMED before starting the next experimental session. 

22. It is a good practice to clean tissue baths with a dilute solution of hydrochloric acid 
(HCl, 0.1 N) after use.  This removes salt deposits and keeps glassware clean.  Rinse 
with three washes of distilled water after doing an acid wash. 
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CHAPTER 6  
Designing Protocols for Programmable Stimulators 

User-defined protocols may be created that will perform a series of stimulations in a 
specified pattern.  This feature is particularly useful when the user wishes to stimulate 
the preparation in a repeating fashion, while incrementally changing certain stimulus 
parameters with each successive stimulation.  Measuring the peak contraction in 
response to stimulations of increasing pulse frequencies, while maintaining all other 
stimulus parameters constant, is an example of such an application. 

Stimulus Protocol Tutorial 

General Information about Protocol Files 

This section is a brief tutorial that describes how to construct protocol files for controlling 
the programmable stimulators.  Refer to Chapter 3 for general information about the 
MyoMED programmable stimulators, including definitions of terms and other conventions. 

A protocol file is a tab-delimited ASCII text file (*.txt) that contains the desired stimulus 
parameters.  Protocol files can be made in any text editor, and should be saved as tab-
delimited ASCII files with a “txt” extension.  This tutorial will use Microsoft® Excel to 
construct a protocol file. 

Each stimulus in a protocol is coded by a single column in the protocol file.  After all 
stimuli have been coded, a final column of zeros must be included to indicate the end of 
the file.  Thus, a protocol file consists of n+1 total columns of data, where n is the total 
number of stimulations to be conducted.  For example, if a protocol file that will perform 
10 stimulations is created, there will be 11 total columns (10 stimulations plus final 
column of zeros).  Each column will have 8 rows of data that contain the desired settings 
for an individual stimulus.  Table 6-1 shows the definitions for each row in the protocol 
file.  A file named “Definitions.txt” that contains the information in Table 6-1 is created in 
the …\MyoMED\Tables directory when the software is installed. 
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Table 6-1 - Protocol File Definitions 

Row 1 Pulses/sec X 10 Example: 15 = 1.5 pulses/sec. 

Row 2 Polarity 0=DC+, 1=DC-, 2=AC (+/-) 

Row 3 Pulse Width (msec) See Figure 3-5 

Row 4 Stimulus Duration (sec) See Figure 3-6 

Row 5 Intensity (Volts) 0 to 40 (or 0 to 400 milliamps) 

Row 6 Repeat Mode Must be 2 to continue using File 

Row 7 Repeats # of stimulus repeats before moving to next column 

Row 8 Repeat Rate (sec) Delay before next stimulation for Repeat or next column 

 

• Row 1 contains the value for pulse rate in Hz, or pulses per second, multiplied by 10.  
It is important to remember the 10-times multiplication factor.  If a pulse rate of 1 
pulse per second is desired, the value entered into row 1 should be 10.  For a pulse 
rate of 2.5 pulses per second, the value entered into row 1 should be 25.  For 15 
pulses per second, enter 150 into row 1.  Keep in mind that the total number of 
pulses during a given stimulus will be the result of the pulse rate multiplied by the 
stimulus duration.  If it is desired to have a stimulus that consists of a single pulse, 
one way to achieve this would be to enter “10” into row 1 for 1 pulse per second, and 
enter “1” into row 4 for 1 sec stimulus duration (1 pulse per sec X 1 sec = 1 pulse). 

• Row 2 contains the setting for pulse polarity.  A value of “0” will give positive pulses.  
A value of “1” will give negative pulses.  A value of “2” will give alternating positive 
and negative pulses.   

• Row 3 contains the value for the pulse width in msec.  This value must be valid for 
the specified frequency.  MyoMED features error checking that ensures compatibility 
between the specified frequency and pulse width.   

• Row 4 contains the value for stimulus duration in sec.  Note that the total number of 
pulses delivered during a given stimulus is the result of the pulse rate (pulses per 
sec) multiplied by the stimulus duration (sec). 

• Row 5 of the protocol file contains the value for the stimulus intensity, or the 
amplitude of a stimulus pulse, in volts or milliamps.  The PHM-152V Constant Voltage 
Programmable Stimulators are capable of pulse amplitudes ranging from 0 to 40 
Volts.  PHM-152I Constant Current Stimulators can produce pulses from 0 to 400 
milliamps. 

• Row 6 is the Repeat Mode setting, and must be set to 2 when using a protocol file.  
The value in row 6 should always be “2.”  Other values are invalid for proper 
stimulator control. 
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• Row 7 contains the value for the number of stimulations using the current set of 
parameters to perform before moving on to the next set of parameters.  In other 
words, row 7 tells the stimulator how many times to use the settings in the current 
column before moving to the next column.  In most cases, the value in row 7 will be 
“1” and the settings in a given column will be used once before moving to the next 
column. 

• Row 8 contains the value for repeat rate in sec.  This value determines the delay 
between successive stimulations.  It is the length of time from the start of one 
stimulus to the start of the next stimulus.  Keep in mind that the repeat rate must be 
entered in seconds. 

Using Microsoft® Excel to Construct Protocol Files 

Take a few moments to plan the experimental protocol.  In most cases, users will want to 
do a series of stimulations with one parameter varying incrementally while all other 
parameters are held constant.  First, decide which stimulus parameter to vary.  Then, 
decide what the fixed values of the other parameters will be.  Finally, decide how many 
successive stimulations to perform. 

In this example, a protocol file will be created that will change the pulse frequency while 
holding the pulse polarity, pulse width, stimulus duration, stimulus intensity, and repeat 
rate constant.  This file will contain 12 individual stimulations, with 3 minutes (180 sec) 
between each stimulus.  Thus, the protocol file will consist of 13 columns, 12 columns for 
the stimulations and a final column of zeros to signal the end of the protocol. 

Pulse frequencies of 1, 2, 3.5, 5, 7.5, 10, 12.5, 15, 20, 30, 40, and 50 pulses/sec will be 
used.  Pulse polarity will be AC (+/-), pulse width will be 0.2 msec, stimulus duration will 
be 2 sec, stimulus intensity will be 20 Volts, and the repeat rate will be 180 sec.  Refer to 
Chapter 3 if more information is needed regarding any of these stimulus parameters. 

Once the stimulus settings for the protocol file have been selected, begin by opening a 
new worksheet in Excel (Figure 6-1). 

 

Figure 6-1 - New Microsoft Excel Worksheet 
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In column A, enter the fixed stimulus settings in their respective rows.  Refer to Table 5-
1 to see which rows the individual parameters should be entered into.  In this example, 
leave row 1 blank since this row will contain the stimulus frequency, which will change 
from stimulus to stimulus.  Enter “2” in row 2 to indicate AC (+/-) polarity.  Enter “0.2” in 
row 3 for 0.2 msec pulse duration.  Enter “2” in row 4 for a stimulus duration of 2 sec.  
Enter “20” in row 5 for a pulse intensity of 20 Volts.  Enter “2” in row 6 to enable the 
MyoMED software to use the protocol file.  Enter “1” in row 7.  This indicates that the 
programmable stimulator will use settings from this column once, and then use the next 
column for the next stimulus.  Enter “180” in row 8 to indicate a delay of 180 sec until 
the next stimulus is initiated.  Figure 6-2 illustrates how the Excel spreadsheet should 
appear at this point. 

 

Figure 6-2 - First Column of Sample Protocol File 

 
 

Now highlight rows 2 through 8 in column A and copy them to the clipboard.  Since we 
want 11 more columns to code the 12 total stimulations, paste the values from column A 
rows 2 through 8 into rows 2 through 8 of columns B through L.  Enter “0” in rows 1 
through 8 of column M to indicate the end of the protocol file.  Figure 6-3 shows how the 
Excel spreadsheet should appear at this point. 

 

Figure 6-3 - Constant Settings Entered in Protocol File 

 
 

Now, enter the value for stimulus frequencies in row 1 of columns A through L.  Recall 
that the value entered into row 1 will be the desired stimulus frequency multiplied by 10.  
In this example, we want stimulus frequencies of 1, 2, 3.5, 5, 7.5, 10, 12.5, 15, 20, 30, 
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40, and 50 pulses per second.  Enter 10 in cell A1 (row 1 column A).  Enter 20 in cell B1.  
Enter 35 in cell C1.  Enter 50 in cell D1.  Enter 75 in cell E1.  Enter 100 in cell F1.  Enter 
125 in cell G1.  Enter 150 in cell H1.  Enter 200 in cell I1.  Enter 300 in cell J1.  Enter 
400 in cell K1.  Enter 500 in cell L1.  Again, column M should contain all zeros.  Figure 
6-4 shows how the Excel spreadsheet should appear at this point. 

 

Figure 6-4 - Completed Protocol File 

 
 

Now the protocol file must be saved as an ASCII text tab-delimited file.  In Excel, go to 
File | Save As.  This will bring up the Save As dialog (Figure 6-5).  In the “Save in:” 
field, select a directory to store the protocol file.  A “Tables” directory is created in the 
MyoMED program directory when the software is installed and it is a convenient directory 
in which to store protocol files.  This directory is used for this example.  From the “Save 
as type:” drop-down list, select “Text (Tab delimited) (*.txt)” for the file type.  In the 
“File name:” box enter a name that will allow easy recognition the protocol file at a later 
date.  In this example, the name “Freq1to50Hz.txt” is used.  Once the file is named, click 
Save in the Save As dialog. 
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Figure 6-5 - Saving the Protocol File 

 

 

At this point, a warning message will appear indicating that “the selected file type does 
not support workbooks that contain multiple sheets” (Figure 6-6).  Click OK.  A second 
message appears stating “your_file_name.txt may contain features that are not 
compatible with Text (Tab delimited)…” (Figure 6-6).  Click OK.  The protocol file is now 
ready to be used in MyoMED.   

 

Figure 6-6 - Warning Messages When Saving a Protocol File 
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APPENDIX A  
Force Transducer Calibration 

MyoMED myograph systems include a useful software utility for calibrating force 
transducers called MyoCalibrate.  A shortcut to this program is created on the desktop at 
the time of software installation. 

Catamount Research and Development, Inc. recommends that users perform the 
calibration procedure for all force transducers in a new system before beginning 
experiments.  MyoMED myograph systems also include a set of calibration weights of 
masses 1 gram, 2 grams, and 5 grams. 

MyoCalibrate Software Overview 

The MyoCalibrate interface is shown in Figure A-1. 

 

Figure A-1 - MyoCalibrate Utility 

 
 

The Channel selector indicates the channel affected by the calibration procedure.  Use 
the up and down arrows to change channels. 

The Zero (Tare) button compensates for offset. 

The Calibrate button updates the Calibration Factor. 

The Save and Increment button records the Calibration Factor for the currently 
selected channel to a configuration file and automatically advances to the next channel.  
Previously saved Calibration Factors are overwritten in this process. 

The Skip and Increment button ignores the Calibration Factor for the currently 
selected channel and automatically advances to the next channel.  Previously saved 
Calibration Factors are not changed in this process. 
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The Calibration Factor indicator shows the sensitivity of the force transducer in units 
per volt.  It is updated when the Calibrate button is pressed.  The Calibration Factor 
is used by MyoMED software during data acquisition so that recorded data are in units of 
grams. 

The Force indicator displays the reading from the force transducer using the current 
Calibration Factor. 

The Quit button exits the MyoCalibrate program. 

Calibration Procedure 

Run the MyoCalibrate program by clicking on the desktop shortcut.  Start by calibrating 
the force transducer connected to Channel 1.  Channel 1 should be listed in the Channel 
selector box (Figure A-3). 

Begin by choosing the appropriate calibration weight, and then select the calibration 
weight value in the Calibration weight box in the MyoCalibrate window (Figure A-3). 

 

Figure A-2 - Calibration Kit (1,2 and 5 grams) 

 
 

Figure A-3 - Selecting Calibration Weight Value 

 
 

Attach the tissue hook to the force transducer as shown Figure A-4. Once the weight 
hanger is attached to the force transducer adjust the Offset knob on the Radnoti 
Isometric Transducer (Figure 1-6) until the “Volts Output” display on the Transducer 
reads “0”, then click the Zero button in the MyoCalibrate window.  The Weight indicator 
should read close to 0 grams. 
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Figure A-4 - Attaching the Tissue Hook 

 

Next, hang the weight on the tissue hook (Figure A-5).  Wait a few moments for the 
reading on the Force indicator to stabilize.  Press the Calibrate button.  Notice the 
Calibration Factor indicator has been updated.  Press Save and Increment to record 
the new Calibration Factor to the configuration file, remove the calibration weight and 
leave the tissue hook, then proceed with calibrating the next channel. 

 

Figure A-5 - Calibration Using the 5-Gram Weight 

 

Once all channels have been calibrated, press the Quit button to exit MyoCalibrate.  The 
system is now ready to record data using the MyoMED software. 
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APPENDIX B  
MyoMED Calibration Exercise 

Purpose 

This exercise is a simple procedure that presents the user with a series of steps that 
progress through the basic stages of calibration and validation of the myograph 
instrument.  The user will become familiar with basic operation of the myograph 
hardware and software, including analyzing raw data. 

Procedure 

Calibration 

1. Calibrate the system following the instructions in Appendix A. 

Validation 

There are three stages to the validation portion of the exercise: 1) Acquiring data, 2) 
Analyzing data, and 3) Calculations. 

Acquiring data 

1. Run MyoMED software by clicking on the desktop shortcut. 

2. Begin recording an experimental session by choosing Start Session from the File 
menu.  This opens the File Name window.  Type in a file name, such as 
CalibrationTest, for the experiment.  Click OK.  The system is now acquiring data. 

3. Make sure the channel selector is set to Channel 1.   

4. Be sure that the tissue hook used during the calibration procedure is attached to the 
force transducer. 

5. Tare the weight of the hook. 

6. On the Calibration Worksheet included in this section, record the force observed in 
the force display window (labeled “Grams Net”) next to the force trace.  This value 
should be close to “0”. 

7. Attach the 1-gram weight from the calibration kit to the tissue hook and allow about 
30 seconds for stabilization, then record the force observed on the Calibration 
Worksheet. 

8. Remove the 1-gram weight from the tissue hook. 

9. Attach a 2-gram weight to the tissue hook and allow about 30 seconds for 
stabilization, then record the force observed on the Calibration Worksheet. 

10. Remove the 2-gram weight from the tissue hook. 

11. Attach a 5-gram weight to the weight hook and allow about 30 seconds for 
stabilization, then record the force observed on the Calibration Worksheet. 

12. Remove the 5-gram weight from the force transducer. 
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13. Change the Channel Selector to the next channel. 

14. Repeat steps 4-13 for the remaining channels. 

15. Stop recording data in MyoMED by selecting Stop Session from the File Menu, and 
then close MyoMED by selecting Quit from the File Menu. 

Analyzing data 

1. Open MyoViewer data analysis software by clicking on the desktop shortcut. 

2. Open the data file that was just created (e.g. CalibrationTest).  Start by loading 
Channel 1 of the data file. 

3. Configure the MyoViewer data display window to show the portion of the data file 
where the calibration weights were being applied.  There should be a staircase 
pattern with 3 steps (one for each calibration weight). 

4. Place the data analysis Cursors A and B at a distance of 10 sec apart in the region of 
the trace after the weight of the weight hanger hook was tared, but before the 1-
gram weight was applied. 

5. Recorded the Mean Grams measured between Cursors A and B in the space 10 sec 
Avg Force (grams) on the Calibration Worksheet included in this section. 

6. Move Cursors A and B to the part of the trace that was stable after adding the 1 
gram weight.  Again, place the cursors 10 sec apart. 

7. Record the Mean Grams between the analysis cursors in the space 10 sec Avg Force 
(grams) on the Calibration Worksheet. 

8. Move cursors to the part of the trace that was stable after adding the 2-gram weight.  
Again, place the cursors 10 sec apart. 

9. Record the Mean Grams between the analysis cursors in the space 10 sec Avg Force 
(grams) on the Calibration Worksheet. 

10. Move the cursors to the part of the trace that was stable after adding the 5-gram 
weight.  Again, place the cursors 10 sec apart. 

11. Record the Mean Grams between the analysis cursors in the space 10 sec Avg Force 
(grams) on the Calibration Worksheet. 

12. Repeat Steps 3 - 11 for the remaining channels. 

13. Once all of the calibration data has been recorded for each channel, quit MyoViewer 
software. 
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Calculations 

There are two calculations associated with determining the effectiveness of the 
calibration and validation procedure. 

1. Determine the difference between the actual weight applied (grams) and the 
measured force (grams) for each weight level using the following formula: 

Force measured (10 sec Avg Force (grams)) – Weight Applied (grams) = Difference (grams) 

Record the Difference (grams) in the spaces provided on the Calibration Worksheet. 

2. Determine the percent error in the measured force from the actual weight applied 
using the following formula: 

[Difference (grams) / Weight Applied (grams)] * 100 = Error (%) 

Record the Error % in the space provided on the Calibration Worksheet. 

NOTE:  There is no Error % for the baseline condition where no weight is applied (0 
grams).  The mathematical operation is undefined (contains a divide by 0). 

NOTE:  The Error % varies slightly from channel to channel.  However in most cases, the 
error will be less than 1 %, and is rarely greater than 3 %.  Errors much greater than 
this indicate a problem in the calibration.  Attempt to recalibrate the affected channels.  
Take special care to ensure the tissue hook is attached to the force transducer 
consistently each time.  This can take some practice.  With practice, the errors should 
drop to an acceptable percent.  If this is not the case, there may be a problem with the 
force transducer. 
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Calibration Worksheet 
 

Channel 1 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0       

1       

2       

5       
 

Channel 2 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0    

1    

2    

5    

 

Channel 3 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0    

1    

2    

5    

 

Channel 4 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0    

1    

2    

5    

 

 

Channel 5 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0       

1       

2       

5       
 

Channel 6 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0    

1    

2    

5    
 

Channel 7 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0    

1    

2    

5    

 

Channel 8 
Weight 
Applied 
(grams) 

10 sec Avg 
Force 

(grams) 

Difference 
(grams) Error % 

0    

1    

2    

5    
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APPENDIX C  
File Types  

RAW (experiment) 

TXT (event marks) 

CHx (modified event comments, X = channel number) 

TXT (exported data) 

TXT (protocol file) 

HTM (printout) 

PNG (printout) 
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APPENDIX D  
Sample MyoViewer Printout 
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APPENDIX E  
Software Installation 

If a computer was purchased from Catamount Research and Development, Inc. as part of 
the myograph system, all software and drivers are pre-installed and it is not necessary to 
perform any software installation.  Software installation is only necessary if the computer 
being used with the system was not purchased from Catamount Research and 
Development, or data acquisition computers will be changed at a later date. 

Insert the MyoMED software CD into the CD-ROM drive.  The screen shown in Figure E-1 
will appear.  Select the type of MyoMED system being installed and the screen shown in 
Figure E-2 will appear. 

 

Figure E-1 – MyoMED Main Screen 

 
 

Enter the MyoMED password that was issued when the software was registered and click 
OK.  The screen shown in Figure E-3 will appear. 

 

Figure E-2 – Enter MyoMED Password 
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Click Install to begin driver and software installation.  A successful installation will be 
indicated with a green check mark, and an unsuccessful installation will be indicated with 
a red X.  If any portion of the installation is unsuccessful, please contact Catamount 
Research and Development Customer Support. 

 

Figure E-3 – Begin MyoMED Installation 

 
 

Once the DIG-729 driver has been successfully installed, the NI-DAQ driver installation 
will begin with the screen shown in Figure E-4.  Click Next to proceed with installation 
and the screen shown in Figure E-5 will appear. 

 

Figure E-4 – Beginning NI-DAQ Driver Installation 
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The default destination directory is shown.  If this directory is acceptable, click Next to 
continue and the screen shown in Figure E-6 will appear.  If it is not, click Browse… and 
browse to the desired directory. 

 

Figure E-5 – Select Destination Directory 

 
 

Select the features to install and click Next to continue.  The screen shown in Figure E-7 
will appear. 

 

Figure E-6 – Select Features 
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Review the National Instruments Software License Agreement, then select I accept the 
License Agreement(s).  Click Next to continue and the screen shown in Figure E-8 will 
appear. 

 

Figure E-7 – License Agreement 

 
 

Review the installation information summary and click Next to complete installation.  
The screen shown in Figure E-9 will appear. 

 

Figure E-8 – Start NI-DAQ Installation 
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The NI-DAQ driver installation is now complete.  Click Finish to close this window and 
the screen shown in Figure E-10 will appear. 

 

Figure E-9 – NI-DAQ Driver Installation Complete 

 
 

Close all programs and click Next to proceed with MyoMED software installation.  The 
screen shown in Figure E-11 will appear. 

 

Figure E-10 – MyoMED Installation Wizard 
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The default destination folder for the MyoMED software is shown.  If this folder is 
acceptable, click Next to continue and the screen shown in Figure E-12 will appear.  If 
this folder is not acceptable, click Browse and browse to the desired folder. 

 

Figure E-11 – MyoMED Destination Folder 

 
 

Click Next to complete the MyoMED software installation and the screen shown in Figure 
E-13 will appear. 

 

Figure E-12 – Ready to Install the Application 
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The MyoMED software installation is now complete; click Finish to close this window and 
the screen shown in Figure E-14 will appear. 

 

Figure E-13 – MyoMED Installation Complete 

 
 

Click Finish to close this window and the screen shown in Figure E-15 will appear. 

 

Figure E-14 – Installation Wizard Complete 
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The computer must be restarted before the MyoMED software can be used.  Click Yes to 
restart the computer now and No to restart at another time. After the computer has 
restarted, start the Measurement and Automation program by clicking on the 
appropriate shortcut icon on the desktop.  The screen shown in Figure E-16 will appear. 

 

Figure E-15 – Restart Needed 

 
 

From the Configuration window on the left side, expand the Devices and Interfaces 
folder by double clicking on it.   

 

Figure E-16 - Measurement and Automation Explorer 
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Right click on PCI-6023E (Device1) and the menu shown in Figure E-17 will appear.  
Click Properties… and the screen shown in Figure E-18 will appear. 

 

Figure E-17 – PCI-6023E Properties 

 
 

Click the Test Resources button and the screen shown in Figure E-19 will appear. 

 

Figure E-18 - Configuring Device 1: PCI-6023E 

 
 

Click OK to close this window.  Close the screen shown in Figure E-18 by clicking OK and 
the screen shown in Figure E-16 will appear.  Close this screen by selected File | Exit.  
The DIG-744 (NI-DAQ) card and its drivers should now be installed correctly. 

 

Figure E-19 – NI-DAQ Configuration Utility 
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